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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. TheTechnical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, theTechnical Support groupworkswithProductEngineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week

■ Advanced features, including Account Management Services

For information about Symantec’sMaintenance Programs, you can visit ourWeb
site at the following URL:

www.symantec.com/techsupp/

Contacting Technical Support
Customerswith a currentmaintenance agreementmay access Technical Support
information at the following URL:

www.symantec.com/techsupp/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer onwhich theproblemoccurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

www.symantec.com/techsupp/
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■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If yourSymantecproduct requires registrationor a licensekey, access our technical
support Web page at the following URL:

www.symantec.com/techsupp/

Customer service
Customer service information is available at the following URL:

www.symantec.com/techsupp/

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and maintenance contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

www.symantec.com/techsupp/
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Maintenance agreement resources
If you want to contact Symantec regarding an existing maintenance agreement,
please contact the maintenance agreement administration team for your region
as follows:

contractsadmin@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Additional enterprise services
Symantec offers a comprehensive set of services that allow you tomaximize your
investment in Symantec products and to develop your knowledge, expertise, and
global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber attacks, comprehensive threat
analysis, and countermeasures to prevent attacks before they occur.

SymantecEarlyWarningSolutions

These services remove the burdenofmanaging andmonitoring security devices
and events, ensuring rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site technical expertise from
Symantec and its trustedpartners. SymantecConsultingServices offer a variety
of prepackaged and customizable options that include assessment, design,
implementation,monitoring, andmanagement capabilities. Each is focused on
establishing andmaintaining the integrity and availability of your IT resources.

Consulting Services

Educational Services provide a full array of technical training, security
education, security certification, and awareness communication programs.

Educational Services

To access more information about Enterprise services, please visit our Web site
at the following URL:

www.symantec.com

Select your country or language from the site index.
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Introducing Deployment
Solution for Dell Servers

This chapter includes the following topics:

■ About Deployment Solution for Dell Servers

About Deployment Solution for Dell Servers
You can remotely manage and automate the administration of your Dell servers
using Deployment Solution for Dell Servers.

See “Using Deployment Solution for Dell Servers” on page 11.

This software addition toDeployment Solution lets youmanage yourDell servers.
You can create tasks from the predefined task types that Deployment Solution
for Dell provides. These tasks can configure your BIOS interfaces, DRAC (Dell
remote access controller) cards, and RAID systems. You can also create a task to
define dynamic types of RAID configurations. You can install an operating system
using a scripted install or image and update hardware configurations.

See “About deployment tasks and jobs for Dell servers” on page 23.

You can also useDeployment Solution forDell to remotely provision servers using
zero-touch functionality. You can remotely install servers out of the box and
manage those servers across their life cycle.

See “Provisioning a Dell server” on page 19.

You should already be familiar with Deployment Solution and how to use its
features, such as:

■ Creating a deployment task

■ Scheduling a deployment task

1Chapter



■ Checking the state of a task

■ Combining tasks into jobs

Formore information, see theDeploymentSolutionHelp. You can access this guide
from the Symantec Management Console on the Help > Documentation Library
menu.

Introducing Deployment Solution for Dell Servers
About Deployment Solution for Dell Servers
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Getting started with
Deployment Solution for
Dell Servers

This chapter includes the following topics:

■ Using Deployment Solution for Dell Servers

■ Creating a PXE pre-OS image for a Dell server

■ Installing WinRM

Using Deployment Solution for Dell Servers
You can use Deployment Solution for Dell in many ways to manage your Dell
servers.

You can also perform a scripted OS installation.

See “Performing a scripted OS installation without PXE” on page 37.

Table 2-1 describes one way you can use Deployment Solution for Dell to manage
your Dell servers.

2Chapter



Table 2-1 Process for using Deployment Solution for Dell Servers

DescriptionActionStep

You can use PXE to boot your Dell servers
using a network interface. You use a pre-OS
configuration to create a PXE image. Tasks can
then access and use that specific image.

See “Creating a PXE pre-OS image for a Dell
server” on page 13.

(Optional) Create a PXE
pre-OS image for a Dell
server.

Step 1

You don’t have to use PXE to set up your Dell
servers for the first time. You can use
provisioning. Provisioning lets you
communicate with each server to direct what
tasks to run. You can use zero-touch
functionality to boot into a network ISO, set
up your hardware, or perform a scripted OS
installation. Provisioning lets you complete all
of these tasks without using PXE.

See “About zero-touch provisioning”
on page 17.

If you don’t want to provision your Dell
servers, skip to Step 5.

(Optional) Use
provisioning to set up your
servers.

Step 2

WinRM lets you communicate with the DRAC
card on each of your servers. It is Microsoft’s
standard for remote management and allows
administrators to remotely execute and
manageWindows computers. Youmust install
WinRM to use some of the provisioning tasks
that are provided in Deployment Solution for
Dell.

See “Installing WinRM” on page 15.

Install WinRM.Step 3

You need to create the credentials that you
want to use with all of the tasks that require
authentication.

WS-MAN is the protocol that the DRAC card
uses to communicate. By creating theWS-MAN
credentials, you can log on to the DRAC and
boot to anetwork ISOormanageother features
of the server.

See “Creating provisioning credentials”
on page 18.

Create the provisioning
credentials.

Step 4

Getting started with Deployment Solution for Dell Servers
Using Deployment Solution for Dell Servers
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Table 2-1 Process for using Deployment Solution for Dell Servers (continued)

DescriptionActionStep

You can manage your Dell servers using tasks
and jobs. Tasks are individual processes, such
as booting to a network ISO or configuring a
DRAC card. Each task can then be scheduled
and run.

Deployment Solution for Dell includes a
number of predefined tasks types that you can
use to create tasks.

See “About deployment tasks and jobs for Dell
servers” on page 23.

Create Dell tasks.Step 5

You can combine your Dell tasks into a
comprehensive job that handles the setup and
maintenance of your Dell servers.

As one of the Dell jobs, you can use
provisioning to set upyour brandnewservers,
without using PXE. By communicating with
the server’sDRACcard, you canuse zero-touch
functionality to remotely set up any servers
in your environment.

See “About zero-touch provisioning”
on page 17.

See “Provisioning a Dell server” on page 19.

For more information, view topics about
combining tasks into jobs in the Deployment
Solution Help.

Combine your tasks into
jobs.

Step 6

Creating a PXE pre-OS image for a Dell server
Pre-boot eXecution Environment (PXE) is an environment that you canuse to boot
computers using a network interface. This process is independent of your hard
disks or installed operating systems. The site server components in Deployment
Solution include PXE.

For more information, view topics on site server components and PXE in the
Deployment Solution Help.

The Preboot Configuration page lets you add a new policy for a pre-OS
configuration. After you create a configuration policy, you can use it to create a

13Getting started with Deployment Solution for Dell Servers
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PXE image. Tasks can then access and use that pre-OS configuration-based image.
The pre-OS configuration can also be used to create installation files.

This process also creates a resource that can be used to reboot to a task. You can
use the resource to reboot to any job that requires you to reboot to PXE.

If the pre-OS policy is enabled, the server starts building the PXE image after the
server requests an updated configuration. Be aware that new policies or newly
scheduled policies can take up to an hour to load. After the policies are loaded,
the process to create a PXE image takes approximately 20 minutes.

Before you run this task, youneed to boot the server into the pre-OS environment.

Make sure that your PXE server is configured to respond to unknown computers.
For more information on PXE server configuration, see the Deployment Solution
Help.

See “Using Deployment Solution for Dell Servers” on page 11.

To create a PXE pre-OS image for a Dell server

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand theSettings>DeploymentandMigration>Symantec
Boot Services (PXE) folders.

3 Click Preboot Configurations.

4 In the right pane, click Add.

5 On the Add Preboot Configuration page, enter a name and description for
your pre-OS configuration.

6 Select the WinPE operating system from the drop-down menu.

7 Select the x86 architecture.

8 Select the Dell OEM extension from the drop-down menu.

9 Select the pre-OS environment to build.

■ PXE -This pre-OS configuration can be accessed only from thePXE server.
Only the client computers that are configured to boot to and from their
network card can access the configuration.

■ Automation folder - This pre-OS configuration can be installed on the
client computer by using policies. Be careful when using Automation
folderswithRAIDconfigurations.WhenyouperformaRAIDconfiguration,
you clear the Automation folder.
See “Configure RAID - Advanced task type” on page 33.
See “Defining rules for RAID configurations” on page 34.

Getting started with Deployment Solution for Dell Servers
Creating a PXE pre-OS image for a Dell server
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■ Both PXE and Automation folder - This option builds both types of
configurations.

10 Click OK.

11 Ensure that the policy is enabled.

A green On symbol shows in the top right corner.

12 Click Save changes.

Installing WinRM
WinRM is short forWindowsRemoteManagement, which is freely available from
Microsoft. It is the Microsoft standard for remote management and allows
administrators to remotely execute and manage Windows computers.

Youmust installWinRM1.1 or later to run the provisioning tasks.WinRM should
be installed on the same computer that your Notification Server is installed on.
It also needs to be installed on any task servers that are associated with that
Notification Server.

For more information about installing WinRM on site servers, see
https://kb.altiris.com/article.asp?article=52114&p=1.

WinRM sends tasks or commands to your server’s DRAC using the WS-MAN
protocol.

See “Creating provisioning credentials” on page 18.

For example, WinRM tells the DRAC to reboot to a network ISO and unpack and
attach drivers for an OS scripted installation.

See “Provisioning a Dell server” on page 19.

See “Using Deployment Solution for Dell Servers” on page 11.

To install WinRM

1 In your browser, go to
http://www.microsoft.com/downloads/details.aspx?FamilyID=845289ca-
16cc-4c73-8934-dd46b5ed1d33&displaylang=en.

2 Download the correct WinRM executable file or your operating system.

3 Run the executable file to install WinRM.

4 Run the following command:

winrm set winrm/config/client/auth @{Basic="True"}

15Getting started with Deployment Solution for Dell Servers
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Provisioning Dell servers

This chapter includes the following topics:

■ About zero-touch provisioning

■ Creating provisioning credentials

■ Provisioning a Dell server

■ Adding a certificate trust list to IIS

About zero-touch provisioning
Zero-touch provisioning is a method that you can use to set up your brand new
servers, without using PXE. By communicating with the server’s DRAC card, you
can use this functionality to remotely set up any servers or perform other tasks.

See “Using Deployment Solution for Dell Servers” on page 11.

See “Creating provisioning credentials” on page 18.

See “Provisioning a Dell server” on page 19.

Zero-touch provisioning works in the following manner:

■ You plug in your server.

■ The DRAC card on your server starts up, finds the Deployment Solution for
Dell provisioning Web site, and identifies itself as a new DRAC.

■ The Web site sends commands back to the DRAC.

■ The DRAC is added to the CMDB and assigned a task or a job.

The DRAC can then be booted to a network ISO without using PXE. You can also
provision your hardware, perform a scripted OS installation, and complete other
tasks without using PXE.
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Creating provisioning credentials
WS-MAN (Web Services forManagement) is the protocol that theDRAC card uses
to communicate. The DRAC card sits on your Dell server and contains the DRAC
functionality. It lets you boot to a network ISO andhandles features such as power
control, temperature control, remote management, and others. The DRAC runs
independently of the server; it can be on while the system is off. You can
communicate with the DRAC through its own Ethernet jack.

See “About zero-touch provisioning” on page 17.

You can use the First Time Setup page to create the WS-MAN credentials that
you want to use with the tasks that require authentication.

The credentials that you create are added to theDRAC. You can log on to theDRAC
later and complete all of your tasks that require authentication. These tasks
include booting to a network ISO and provisioning your servers.

See if core documentation talks about enabling the WSMan task handler policy
-?

See “Using Deployment Solution for Dell Servers” on page 11.

To create provisioning credentials

1 In the SymantecManagement Console, on theHomemenu, clickNotification
Server Management > First Time Setup.

2 Under Deployment Solution for Dell Servers, click Create a WS-Man
credential.

3 On the Credentials Management page, click Add Credentials.

You can use the pencil icon to edit existing credentials. The X icon lets you
delete the credentials that you select.

4 OntheAddCredentialpage, select theWS-MANCredentialsas the credential
type.

5 Enter a name.

6 Enter the user name for the credentials.

7 Enter the password, and then re-enter the password in theConfirmPassword
box.

8 Select if you want to establish an expiration date for your credentials, and
then choose an expiration date.

9 Select who should be allowed to use the credentials:

■ Only me

Provisioning Dell servers
Creating provisioning credentials
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■ Let me select which users

10 To select the users that can use the credentials, click the Letmeselectwhich
users option, select or add the users that you want, and then click OK.

You can click View to select the permissions that each user has.

11 Click OK.

On the Credentials Management page, the name you entered for your new
credentials appears in the list of credentials.

Provisioning a Dell server
You can use zero-touch provisioning to set up your brand new servers. This
functionality is included in the Dell Server Provisioning task.

See “About zero-touch provisioning” on page 17.

Themain goal of this task is to set the default behavior for new servers. You define
the tasks that should run on every server, as long as you don’t specify tasks based
on every service tag.

If a server’s service tag is in the Predefined Service Tags list, you can specify
what credentials are assigned to that server and what tasks it runs. For example,
service tag X gets credentials Dell and runs the new server job task. When that
server starts up, Deployment Solution already knows about it and can assign it
the proper credentials and run the specified tasks on it.

You can define the default behavior for every new server or specify a different
behavior for every service tag.

After you define the provisioning behaviors, a table displays in the middle of the
task page and contains the following information:

■ Service Tag - A list of service tags that you defined or imported. Service tags
identify Dell servers and are the same as the serial number of the server.

■ iDRAC Credential - The credentials that are needed to access the iDRAC.

■ Deployment Job - The tasks or job to run.

If you have remote site servers in your environment, youmust enable theWSMan
task handler policy on those site servers. The policy must be enabled before you
can provision all of your servers. You can access this policy from the Settings >
All Settings > Agents/Plug-ins > Deployment and Migration > Windows > Dell
Provisioning WSMan Task Handlers Install menu.

See “Using Deployment Solution for Dell Servers” on page 11.

19Provisioning Dell servers
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To provision a Dell server

1 From the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, expand the Deployment and Migration folder.

3 Click Dell Server Provisioning.

4 In the right pane, select any of the following options:

■ Provision only servers with trusted certificates
The certificate on theDRAC shouldmatch theDell certificate onSymantec
Management Platform . If the certificates don’t match, your Dell server
is not provisioned.
If you select this option, youmustmanually add your certificate trust list
(CTL) in IIS.
See “Adding a certificate trust list to IIS” on page 21.

■ Provision only servers that have not been provisioned previously
If the server has been provisioned once, it is not provisioned again.

■ Provision only servers authorized by predefined service tags
You can select the specific servers that you want provisioned. You can
select different credentials for each server and the different tasks that
run on each server. For example, service tag X gets credentials Y and runs
theWindowsOS installation task. If the service tag of a new server doesn’t
match a service tag on the list, it is ignored and not provisioned.

5 Enter the default DRAC credentials.

You can select existing credentials from thedrop-down list or click the ellipses
icon to view additional information about those credentials. You can also
click the pencil icon to edit existing credentials or click the plus icon to add
credentials.

These are the same credentials that you specified in the First Time Setup
page.

See “Creating provisioning credentials” on page 18.

6 Browse to the default deployment job that you want to run on new servers.

7 Click OK.

8 If you want to define specific service tags, click Add to add a service tag to
the list.

You can click Import fromfile to select the service tag from an XML file. You
can also click the pencil icon to edit an entry in the list or click the X icon to
delete the selected service tag.

Provisioning Dell servers
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9 In the Add Predefined Service Tag page, enter the service tag.

10 Enter the credentials.

You can select existing credentials from thedrop-down list or click the ellipses
icon to view additional information about those credentials. You can also
click the pencil icon to edit existing credentials or click the plus icon to add
credentials.

11 Browse to the deployment job that you want to run on that server.

12 Click OK.

Adding a certificate trust list to IIS
You must manually add your certificate trust list (CTL) to IIS so that IIS knows
what certificates you want to match.

See “Provisioning a Dell server” on page 19.

To add a certificate trust list to IIS

1 From Windows, click Start > Administrative Tools > Internet Information
Services (IIS) Manager.

2 In the left pane, expand the Web Sites folder.

3 Right-click Dell Provisioning, and then click Properties.

4 In the Dell Provisioning Properties window, click the Directory Security
tab.

5 Under Secure communications, click Edit.

6 Ensure that the Enable certificate trust list option is selected.

7 Click New.

8 In the Certificate Trust List wizard, click Next.

9 Click Add from Store.

10 From the certificate list, select the iDRAC certificate.

11 Click OK.

12 In the wizard, click Next.

13 Type a name in the friendly name field.

For example, iDRAC_CTL.

14 Click Next.

15 Click Finish.
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16 In the Certificate Trust List wizard succeeded dialog, click OK.

17 Click OK to finish.

Provisioning Dell servers
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Creating tasks and jobs on
Dell servers

This chapter includes the following topics:

■ About deployment tasks and jobs for Dell servers

■ About DTK tasks for Dell servers

■ About Lifecycle Controller tasks for Dell servers

■ Creating a deployment task for a Dell server

■ Viewing a log file for a task

About deployment tasks and jobs for Dell servers
Deployment Solution forDell Serversmanages servers using tasks and jobs. Tasks
are individual processes, such as booting to a network ISO or configuring a DRAC
card. Each task can be scheduled and run.

See “Using Deployment Solution for Dell Servers” on page 11.

Jobs are a combination of tasks. Each job can be assigned to specific servers, and
each job specifies the order in which each task runs. For example, you can create
and run several tasks to perform a scripted OS installation (SOI) job.

See “Performing a scripted OS installation without PXE” on page 37.

Deployment Solution for Dell provides many predefined task types that you can
use to create the tasks that you need. After you create a task, you can specify the
folder that the task is stored in. You can also create new folders for your tasks.
You must create each task before it appears in any folders in the left pane of the
Symantec Management Console.
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See “Creating a deployment task for a Dell server” on page 26.

You can run Dell server jobs and tasks from the Deployment Portal.

For more information about the Deployment Portal, see the Deployment Solution
Help.

Make sure that your server is booted to the proper environment before you run
a task.

Each task saves information about the commands, outputs, and error messages
from that task in a log file.

See “Viewing a log file for a task” on page 27.

Deployment Solution for Dell provides several predefined task types.

See “About DTK tasks for Dell servers” on page 24.

See “About Lifecycle Controller tasks for Dell servers” on page 25.

You can use predefined tasks to change the configuration files and options for
BIOS, DRAC, and RAID.

See “About configuration files” on page 29.

About DTK tasks for Dell servers
Deployment Solution for Dell provides several predefined task types under the
DTK folder.

See “About deployment tasks and jobs for Dell servers” on page 23.

The Simple tasks limit the options that you can change. However, you don’t need
to know the exact command or any of the configuration file information for each
option.

The Advanced tasks capture the complete configuration file that exists on the
specified server and let you see every setting in it. For the BIOS interfaces and
theDRACcards, you can change every setting separately. The tasks for configuring
RAID work in a different manner.

Table 4-1 DTK tasks for Dell servers

DescriptionTask

You can view and change all of the BIOS configuration
settings for a server.

See “Configure BIOS -Advanced task type” onpage 30.

Configure Dell Server BIOS -
Advanced
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Table 4-1 DTK tasks for Dell servers (continued)

DescriptionTask

You can set the asset tag, network cards, BMC IP, LCD
text, and enable or disable the power button.

See “Configure BIOS - Simple task type” on page 31.

Configure Dell Server BIOS -
Simple

You canviewand change all of theDRACconfiguration
settings for a server.

See “ConfigureDRAC -Advanced task type”onpage32.

Configure Dell Server DRAC -
Advanced

You can set the IP address for the management port
and choose what DRAC commands run after the
configuration is finished.

See “Configure DRAC - Simple task type” on page 32.

Configure Dell Server DRAC -
Simple

You can view all of the drives, controllers, and disks
on your server and then configure any of those drives.

See “ConfigureRAID -Advanced task type” onpage 33.

Configure Dell Server RAID -
Advanced

You can use a drag-and-drop tool to define multiple
RAID configurations.

See “Defining rules for RAID configurations”
on page 34.

ConfigureDellServerRAIDwith
Rules

About Lifecycle Controller tasks for Dell servers
Deployment Solution for Dell provides several predefined task types under the
Lifecycle Controller folder. These tasks are mainly used for scripted OS
installations without using PXE.

See “Performing a scripted OS installation without PXE” on page 37.

If you create a job using these tasks, ensure that you create a server job and not
a client job.

See “About deployment tasks and jobs for Dell servers” on page 23.
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Table 4-2 Lifecycle Controller tasks for Dell servers

DescriptionTask

You can boot your server to the pre-OS ISO on the
deployment share without using PXE.

See “Boot to Dell ISO on network task” on page 41.

Boot to Dell ISO on network

You can boot your server to the pre-OS ISO that is on
the Vflash of the Lifecycle Controller.

See “Boot to ISO on Vflash task” on page 40.

Boot To ISO On Vflash

You can close the access to the drivers that are
embedded on the Lifecycle Controller.

See “Close access to drivers task” on page 42.

See “Open access to drivers task type” on page 39.

Close Access To Drivers

You can copy the WinPE ISO for Dell servers to the
Vflash on the Lifecycle Controller of your server.

See “Copy Dell WinPE ISO to Vflash task type”
on page 40.

Copy Dell WinPE ISO To Vflash

You can open the access to the drivers that are
embedded on the Lifecycle Controller.

See “Open access to drivers task type” on page 39.

See “Close access to drivers task” on page 42.

Open Access To Drivers

Before you perform a scripted OS installation, you can
copy the drivers from theDRAC controller to the RAM
drive. This action resolves the issue thatWindowsdoes
not boot correctly if the drivers are present.

See “CopyWindows 2008SOI drivers task” onpage 41.

Windows 2008 SOI Driver Copy

Creating a deployment task for a Dell server
You can run the tasks that configure different types of Dell servers. You can also
run the tasks that manage the Lifecycle Controller on your servers.

See “About deployment tasks and jobs for Dell servers” on page 23.

After a deployment task is created, it is listed under the Jobs and Tasks >
Deployment and Migration > Dell Servers folder. Click any task to view the
properties of that task. You can drag and drop tasks to other folders andmanually
create folders.

Creating tasks and jobs on Dell servers
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Several tasks can also be combined into one job. If you create a job using the
Lifecycle Controller tasks, ensure that you create a server job and not a client job.

For more information on combining tasks into jobs, see the Deployment Solution
Help.

A task cannot be deleted if it is currently in use by a job or policy. You can use the
Jobs and Tasks view on the Manage > Jobs and Task menu to see what jobs and
policies use each task.

Tasks can be renamed, deleted, cloned, moved, and scheduled by right-clicking
the task and selecting the corresponding option.

To create a deployment task for a Dell server

1 From the Symantec Management Console, on the Manage menu, click Jobs
and Tasks.

2 In the right pane, click Create a new job or task.

You can also right-click any folder in the left pane and click New > Task.

3 On theCreateNewJoborTaskpage, in the left pane, expand theDeployment
and Migration > Dell Servers folders.

4 Expand either the DTK folder or the Lifecycle Controller folder.

For the DTK folder, you can choose tasks from the following folders:

■ BIOS

■ DRAC

■ RAID

5 Click one of the tasks that are listed.

For BIOS orDRAC, you can choose fromanAdvanced or Simple configuration
task. For RAID, you can choose either the Advanced configuration or the
configuration with rules task.

6 Select the options that you want.

7 Click OK.

8 Schedule the task.

For more information on scheduling tasks, see the Symantec Management
Platform Help.

Viewing a log file for a task
For each task, Deployment Solution for Dell captures log files.
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See “About deployment tasks and jobs for Dell servers” on page 23.

You can view these log files to see the actual command that ran, as well as its
status and output. You can walk though each task to see the commands that the
task executed and what happened on the client for each command.

For example, if you ran a task that successfully configured the RAID system on a
server, you might see the following information:

■ Step 1: Run task X, which contains command A, to find the controllers on the
disk.
The disk has one controller in slot 0.

■ Step 2: Check for a matching rule.
Yes, there is a rule that matches.

■ Step 3: Delete any existing RAID configurations on the server with command
B.
Command B returned output O, which contains the output and any error
messages.

■ Step 4: Configure the RAID by running command C.
Command C returned output P, which contains the output and any error
messages.
The entire process took S number of seconds.

To view a log file for a task

1 From the Symantec Management Console, on the Manage menu, click Jobs
and Tasks.

2 In the left pane, click any task that executed.

3 In the right pane, under TaskStatus, double-click the task instance that you
want to view the details for.

You can also right-click the task instance, and then click Details.

4 In the task type page, double-click the instance one more time.

You can then use the drop-down lists to view the details for each step in the
task.

Creating tasks and jobs on Dell servers
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Configuring BIOS, DRAC,
and RAID

This chapter includes the following topics:

■ About configuration files

■ Configure BIOS - Advanced task type

■ Configure BIOS - Simple task type

■ Configure DRAC - Advanced task type

■ Configure DRAC - Simple task type

■ Configure RAID - Advanced task type

■ Defining rules for RAID configurations

About configuration files
Deployment Solution for Dell saves configuration files for BIOS, DRAC, and RAID
every time inventory runs. For each type of Dell server, inventory automatically
runs every time that server boots to the Dell WinPE environment. A new DRAC
configuration, BIOS configuration, and RAID configuration file is then stored on
the associated Notification Server. Those configuration files are then stored in
the CMDB.

For example, if youhave a new server, youmight PXEboot it toWinPE if the server
isn’t known to Deployment Solution. The server boots up and gathers inventory,
such as your address name, system name, and other identifying information.
Then, the Dell inventory information is gathered. This information is stored as
the configuration files for that server.
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See “Configure BIOS - Advanced task type” on page 30.

See “Configure BIOS - Simple task type” on page 31.

See “Configure DRAC - Advanced task type” on page 32.

See “Configure DRAC - Simple task type” on page 32.

See “Configure RAID - Advanced task type” on page 33.

See “Defining rules for RAID configurations” on page 34.

Each configuration file is an .ini file that is associated with the target server. The
files are a list of strings that represent the configuration settings.

See “About deployment tasks and jobs for Dell servers” on page 23.

If your serverhas aBMC (baseboardmanagement controller), DeploymentSolution
for Dell also lets you change the configuration settings of the BMC. If your server
does not have a BMC and you attempt to set the BMC configuration settings, you
set the DRAC instead.

Configure BIOS - Advanced task type
This task lets you view and change all of the BIOS configuration settings.

See “Configure BIOS - Simple task type” on page 31.

See “About configuration files” on page 29.

This task supports tokenization. You can use tokens in the configuration file.
Tokens are a text substitution for the information that is stored in the CMDB. For
example,%COMPNAME%. Deployment Solution for Dell queries the CMDB for
the information thatmatches any tokens in your configuration file. Those tokens
are then replaced dynamically with the correct information.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options:

■ Only execute on systems if sysID matches
Select this option if you want this task to run on the servers that have a
matching system identification number. For example, 0235 might match an
R710 server.

■ Only execute on systems with same BIOS version
Select this option if you want this task to run on the servers that have a
matching BIOS version. For example, 1.3.6.

■ Import existing BIOS configuration

Configuring BIOS, DRAC, and RAID
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Select this option if youwant to import the latest, existing BIOS configuration
file from the CMDB. This file is the configuration file that was captured the
last time that the server booted intoDellWinPE. You can then view and change
any option in the list.

Configure BIOS - Simple task type
This task lets you change a subset of the BIOS configuration settings.

See “Configure BIOS - Advanced task type” on page 30.

See “About configuration files” on page 29.

Not all settings are supported on all servers.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

Typically, DHCP is used to assign IP addresses to the DRAC configurations. Most
DHCP servers also let you make static assignments for specific servers. If you
want to assign a specific IP address directly in the configuration file, select the
static option. However, you should also reserve those IP ranges on your DHCP
server to ensure that you won’t have conflicts.

You can change the following BIOS settings:

■ Asset Tag
Enter up to 10 characters to identify the asset.

■ Network Cards
For the first and second embedded NIC cards, you have the following options:

■ Turn on without PXE

■ Turn on with PXE

■ Turn off

■ Base Management Controller (BMC) IP Configuration

■ DHCP (automatic)

■ Static
You have to assign a static IP address manually with this option. Provide
the IP, Gateway, and Subnet addresses.

■ LCD Text (if applicable)
Provide the text to display on your server’s screen.

■ Power Button
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You can enable or disable the power button on your server that controls
whether it is on or off. By disabling the power button, no one can physically
turn off the server.

Configure DRAC - Advanced task type
This task lets you change all of the DRAC configuration settings.

See “Configure DRAC - Simple task type” on page 32.

See “About configuration files” on page 29.

This task supports tokenization. You can use tokens in the configuration file.
Tokens are a text substitution for the information that is stored in the CMDB. For
example,%COMPNAME%. Deployment Solution for Dell queries the CMDB for
the information thatmatches any tokens in your configuration file. Those tokens
are then replaced dynamically with the correct information.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options:

■ Only execute on systems whose DRAC firmware version matches
Select this option to run on the servers that have a matching DRAC firmware
version. For example, version 1.30.
Firmware is the Dell software that is installed on the DRAC that lets you
communicate with the server. Think of it as the operating system for your
DRAC.

■ Only execute on systems whose DRAC type matches
Select this option to run on the servers that have a matching DRAC type. For
example, an iDRAC might be type 10.

■ Import existing DRAC configuration
Select this option to import the latest, existing DRAC configuration file from
the CMDB. This file is the configuration file that was captured the last time
that the server booted into Dell WinPE. You can then view and change any
option in the list.

Configure DRAC - Simple task type
This task lets you change a subset of the DRAC configuration settings.

See “Configure DRAC - Advanced task type” on page 32.

See “About configuration files” on page 29.
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Not all settings are supported on all servers.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

Typically, DHCP is used to assign IP addresses to the DRAC configurations. Most
DHCP servers also let you make static assignments for specific servers. If you
want to assign a specific IP address directly in the configuration file, select the
static option. However, you should also reserve these IP ranges on your DHCP
server to ensure that you won’t have conflicts.

You can change the following DRAC settings:

■ Management port IP settings

■ DHCP (automatic)

■ Static
You have to assign a static IP address manually with this option. Provide
the IP, Gateway, and Subnet addresses.

■ Execute DRAC command (performed after configuration if any)
You can choose to execute different DRAC commands, such as resetting the
DRAC, restoring the factory default settings, and clearing the DRAC logs.

Configure RAID - Advanced task type
This task lets you configure any disks on your server.

See “About configuration files” on page 29.

You can capture two files. The first file lists the hardware on your server and
contains information about that hardware. For example, the file lists each drive
that exists, what type of controllers exist, and the size of each drive. The second
file lists the configuration options that are currently set. For example, the file
lists that the server has one disk that is defined on controller 0, and that disk uses
drives 1-6.

The second file does not show all of the options that are available. This
functionality is different from the way the DRAC and BIOS advanced tasks work.

By comparing the two lists, you can see what disks you have and what disks are
in use. You can then configure any of those disks.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options:

■ Import existing RAID configuration
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This view shows the hardware on your server. It contains information such as
the resource ID and the RAID configuration.

■ Clear RAID Options
You can choose whether the existing RAID configuration is cleared on any
controllers. If you do not clear any existing configurations, your new
configuration fails. You need to manually clear any existing RAID
configurations if you do not select the corresponding option to clear that RAID
configuration.
If you select the option to clear any controller, Deployment Solution for Dell
removes all existing configurations. For example, you have 10 different RAID
configurations on 10 different controllers and select this option. All of those
configurations are cleared.

Defining rules for RAID configurations
This task lets you use a graphical tool to define different RAID configuration rules.
The rules are based on the number of controllers and virtual disks on the RAID.

See “About configuration files” on page 29.

Your RAID controllers are configured according to the order that you add them
in the RAID tool. This order might be different from the order that they display
in the graphical representation on the Configure RAID Controllers page.

The RAID tool is supported officially only on Internet Explorer 8.

The task window graphically represents the server configuration rules that you
created. The first rule thatmatches theRAID is applied. You can change the order
of the rules with the arrow icons.

You can also perform different actions on existing rules by clicking the following
icons:

■ Pencil - Edits the selected rule.

■ X - Deletes the selected rule.

■ Clipboard - Copies the selected rule.

You can access this task from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

To define rules for RAID configurations

1 From the Configure RAID Controllers page, click the Add icon.

A new icon for your rule appears in the list.

2 Ensure that your rule is selected, and then click the pencil icon.
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3 In the RAID tool, drag one of the RAID container types into the right panel.

You define the virtual disks that you want to create on your target server
with the following RAID types:

1-32 drives.RAID 0

2 mirrored drives. Can have up to two dedicated hot spares.RAID 1

3-32 drives. Can have up to four dedicated hot spares.RAID 5

4-16 drives. Must be an even number. Can have up to four
dedicated hot spares.

RAID 10

6-98drives.Must be an evennumber. Canhaveup to 16dedicated
hot spares.

RAID 50

0-16 drives. Cannot be the first disk group. It also cannot follow
a disk group that is assigned no RAID.

Spare (Global
Hotspare)

4 To change the number of drives in each RAID, click the arrow icons in the
right panel.

5 (Optional) Drag anotherRAID type to the right panel and configure that RAID
in a similar manner.

6 Toadd controllers, select theMulti-controllermatching option at the bottom
of the left panel.

This option displays a graphical representation of the controllers on your
server and enables the Add and Remove options. It also enables the arrow
icons at either side of the add and remove options. These icons let you move
the pointer in the graphical representation to the controller that you want
to configure.

The text preceding these options displays how many controllers that you
have currently defined.

7 Ensure that the pointer in the graphical representation at the top of the left
panel points to the controller that you want to configure.
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8 To configure additional matching controllers with this same rule, click
Advanced, and select the option. Enter the text for the controller name, and
then click the close icon in the top right corner.

For example, you have one controller defined. If this option is not selected,
any extra controllers are ignored and are not configured. If you enable this
option, the extra controllers are configured if they match your rule.

When this option is enabled, a blue + icon displays at the top of a controller’s
rule on the main Configure RAID Controllers page. You can click OK at the
bottom of the RAID tool to save your progress and view the corresponding
icon.

9 To restrict this rule to servers that have the same number of controllers that
you define, click Advanced at the bottom of the left panel.

For example, you have two controllers defined. If this option is not selected,
any new servers must have exactly two controllers for this rule to match. If
you enable this option, the new serversmust have at least two controllers for
this rule to match.

The default is to enable this option.When this option is enabled, a blue + icon
displays to the left of the last controller definition on the main Configure
RAID Controllers page. You can click OK at the bottom of the RAID tool to
save your progress and view the corresponding icon.

10 Click OK.
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Performing a scripted OS
installation

This chapter includes the following topics:

■ Performing a scripted OS installation without PXE

■ Open access to drivers task type

■ Copy Dell WinPE ISO to Vflash task type

■ Boot to ISO on Vflash task

■ Boot to Dell ISO on network task

■ Copy Windows 2008 SOI drivers task

■ Close access to drivers task

■ Modifying the answer file

Performing a scripted OS installation without PXE
You can perform a scripted OS installation (SOI) on your Dell servers without
using PXE by creating and running several different tasks.

See “About deployment tasks and jobs for Dell servers” on page 23.

If you perform a 64-bit installation, you must boot into the 64-bit environment
before copying the drivers.

See “Copy Windows 2008 SOI drivers task” on page 41.
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Table 6-1 Process for performing a scripted OS installation without PXE

DescriptionActionStep

You must open the access for the drivers that
match your operating system. You can choose
from specific versions of the Windows, Red
Hat, SUSE Linux, ESX, Hyper-V, or Citrix
operating systems.

See “Open access to drivers task type”
on page 39.

Open the access to the
drivers for the operating
system on the server.

Step 1

You can copy the Dell-specific ISO to Vflash
or use the ISO that is on the network.

If youwant to use the ISO on the network, skip
to Step 5.

Decide if you want to use
the ISO onVflash or on the
network.

Step 2

You need to copy the ISO to Vflash so that you
can boot to it later.

See “CopyDellWinPE ISO toVflash task type”
on page 40.

Copy the Dell-specific
WinPE ISO to Vflash.

Step 3

You can boot your server to the ISO that you
copied to Vflash, and then skip to Step 6.

See “Boot to ISO on Vflash task” on page 40.

Boot to the ISO that is on
Vflash.

Step 4

You can boot your server to the ISO that is on
the network.

See “Boot to Dell ISO on network task”
on page 41.

Boot to the Dell-specific
ISO that is on the network.

Step 5

Youneed to copy thedrivers for your operating
system before you close access to them.

See “Copy Windows 2008 SOI drivers task”
on page 41.

If you use Windows 2008,
copy the SOI drivers.

Step 6

Before you can successfully perform the SOI,
you need to close access to the drivers.

See “Close access to drivers task” on page 42.

Close the access to the
drivers.

Step 7

Performing a scripted OS installation
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Table 6-1 Process for performing a scripted OS installation without PXE
(continued)

DescriptionActionStep

Deployment Solution provides the Install
WindowsOS task. You canaccess the task type
from the Manage > Jobs and Task > Create
New Job or Task menu.

For a Windows 2008 SOI, you must select the
answer file that contains the path to the Dell
drivers.

See “Modifying the answer file” on page 42.

Install the Windows OS.Step 8

Open access to drivers task type
Each DRAC stores drivers for each specific operating system. This task type lets
youopen those drivers for a specificWindows,RedHat, SUSELinux, ESX,Hyper-V,
or Citrix operating system.After the drivers are open, you can then view and copy
the drivers and use them for other tasks.

This task is used mainly for a scripted OS installation (SOI) and is a workaround
for a known issue between Dell drivers and Microsoft processes. If you try to
perform a SOI, the drivers’ presence on the DRAC crashes the installation. As a
workaround, you can open the drivers, copy them from their current location into
aWinPE environment, and then close the drivers. If younow start the installation,
the Microsoft processes cannot see those drivers and the installation completes
successfully.

See “Performing a scripted OS installation without PXE” on page 37.

You can access this task type from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

See “Close access to drivers task” on page 42.

This task contains the following options:

■ Operating system
From the drop-down list, you can choose a specific operating system to open
the drivers for.

■ Advanced

■ Script tab
You can choose to save the script output with the task status.
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■ Run options tab
You can choose to allow other tasks to run while this task is running.
You can also choose to end the task after the number of minutes that you
specify. The default is 30 minutes.

Copy Dell WinPE ISO to Vflash task type
This task type lets you copy the Dell-specific WinPE ISO to your Lifecycle
Controller Vflash.

See “About deployment tasks and jobs for Dell servers” on page 23.

This task type is one of several tasks that can be included in a scripted OS
installation job.

See “Performing a scripted OS installation without PXE” on page 37.

You can access this task type from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options:

■ You can select a Dell WinPE for a 32-bit, 64-bit, or Linux operating system.

■ Advanced

■ Script tab
You can choose to save the script output with the task status.

■ Run options tab
You can choose to allow other tasks to run while this task is running.
You can also choose to end the task after the number of minutes that you
specify. The default is 30 minutes.

Boot to ISO on Vflash task
This task type lets you boot to a Dell-specific WinPE ISO for any task that does
not require PXE.

This task type is one of several tasks that can be included in a scripted OS
installation job. Before you use this task, you must copy the ISO to Vflash using
the Copy Dell WinPE ISO to Vflash task.

See “Copy Dell WinPE ISO to Vflash task type” on page 40.

See “Performing a scripted OS installation without PXE” on page 37.

You can access this task type from the Create New Job or Task page.

Performing a scripted OS installation
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See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options after you click Advanced:

■ Script tab
You can choose to save the script output with the task status.

■ Run options tab
You can choose to allow other tasks to run while this task is running.
You can also choose to end the task after the number of minutes that you
specify. The default is 30 minutes.

Boot to Dell ISO on network task
This task type lets you boot to a Dell-specific WinPE ISO. You can boot to the Dell
pre-OS ISO on the deployment share without using PXE.

This task type is one of several that can be included in a scripted OS installation
job.

See “Performing a scripted OS installation without PXE” on page 37.

If you boot to Linux, you cannot use any of the functionality that Deployment
Solution for Dell specifically provides. If you boot to Windows, you can use the
same functionality as if you PXE booted to WinPE.

You can access this task type from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options:

■ You can select a Dell WinPE for a 32-bit, 64-bit, or Linux operating system.

■ Advanced

■ Script tab
You can choose to save the script output with the task status.

■ Run options tab
You can choose to allow other tasks to run while this task is running.
You can also choose to end the task after the number of minutes that you
specify. The default is 30 minutes.

Copy Windows 2008 SOI drivers task
This task type lets you copy drivers from the iDRAC to the RAM drive before you
perform a scripted OS installation (SOI) of Windows 2008.

See “Performing a scripted OS installation without PXE” on page 37.
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You can use the Lifecycle Controller drivers to perform a 64-bit SOI. However,
you must boot into the 64-bit environment before you copy the drivers or launch
the SOI task. You also must use the Dell iDRAC Windows 2008 SOI Driver Copy
sample task.

You can access the 64-bit task from the Manage > Jobs and Tasks > System Jobs
and Tasks > Dell Server Deployment menu. This task also works in a 32-bit
environment.

The Windows 2008 SOI Driver Copy task type works only for a 32-bit
environment.You can access this task type from theCreateNewJoborTaskpage.

See “Creating a deployment task for a Dell server” on page 26.

Close access to drivers task
This task type lets you close the access to the drivers that are embedded on the
Lifecycle Controller.

This task is used mainly for a scripted OS installation (SOI) and is a workaround
for a known issue between Dell drivers and Microsoft processes. If you try to
perform a SOI, the drivers’ presence on the DRAC crashes the installation. As a
workaround, you can open the drivers, copy them from their current location into
aWinPE environment, and then close the drivers. If younow start the installation,
the Microsoft processes cannot see those drivers and the installation completes
successfully.

See “Performing a scripted OS installation without PXE” on page 37.

You can access this task type from the Create New Job or Task page.

See “Creating a deployment task for a Dell server” on page 26.

This task contains the following options after you click Advanced:

■ Script tab
You can choose to save the script output with the task status.

■ Run options tab
You can choose to allow other tasks to run while this task is running.
You can also choose to end the task after the number of minutes that you
specify. The default is 30 minutes.

Modifying the answer file
The location where you copied your Windows 2008 driver files for your scripted
OS installation (SOI) is saved in an XML file. This file is called an answer file or
an unattend file. This answer file directs Deployment Solution to look in the path
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that you specify for your additional drivers so the installation completes
successfully.

See “Performing a scripted OS installation without PXE” on page 37.

To modify the answer file

1 In Windows, browse to the C:\Program Files\Altiris\Notification

Server\NSCap\bin\Win32\X86\Deployment\SOI\Answer File\ directory.

2 In your text editor, open the following files:

■ Unattend_Inventory_2k8.xml

This file corresponds to the Use inventory data option in the Install
Windows OS task.

■ Unattend_Default_2k8.xml

This file corresponds to the Use default option in the Install Windows
OS task.

3 At the end of each file, add the following section:

<settings pass="offlineServicing">

<component name="Microsoft-Windows-PnpCustomizationsNonWinPE"

processorArchitecture="@ProcessArchitecture"

publicKeyToken="31bf3856ad364e35" language="neutral"

versionScope="nonSxS"

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<DriverPaths>

<PathAndCredentials wcm:action="add" wcm:keyValue="1">

<Path>X:\Windows\Temp\Lifecycle\$WinPEDriver$</Path>

</PathAndCredentials>

</DriverPaths>

</component>

</settings>

This addition should be inserted immediately before the closing tag:

</unattend>

4 Save and close each file.

5 As another option, you can use these files as a template to create a file that
you can browse to in the Install Windows OS task.
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